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My	favorite	thing	about	Sketch:	the	many	ways	it	gives	you	to	organize	and	automate	the	design	process.	An	entire	website	or	app,	complete	with	endless	pages	and	views,	all	stored	inside	a	single,	shareable	.sketch	file.In	this	post	we'll	look	at	the	main	players	in	our	Sketch	toolbox:	pages,	artboards,	and	styling.	We'll	use	these	tools	to	create	a	base
file	from	which	we'll	eventually	build	a	website.Sketch	is	available	for	$99	via	the	Bohemian	Coding	site	(opens	in	new	tab).	It's	worth	noting	that	Sketch	is	available	for	Mac	OSX	only.InVision	is	available	free	forever	(opens	in	new	tab).	It's	an	online	tool,	so	anyone	with	a	browser	can	participate.Got	'em	both?	Then	you're	ready	to	start	setting	up
your	first	Sketch	document.A	page	is	an	individual	canvas	area	inside	a	single	.sketch	document.	Pages	are	the	top	level	of	organization	in	the	document	hierarchy,	which	is	stacked	like	so:	Document>Pages>Artboards>Layers.Pages	are	perfect	for	keeping	even	the	most	complex	build	organized.	You	can	move	from	page	to	page	with	the	menu	at	the
top	of	the	Layers	List.Use	the	dropdown	menu	to	navigate	between	pages	in	your	document.	Notice	that	not	all	my	Sketch	pages	are	literal	pages,	like	in	a	website.	I	use	pages	for	all	sorts	of	high-level	organizing	While	pages	give	you	separated	space	to	work	and	focus,	Symbols	and	Styles	will	work	cross-page	just	fine,	making	consistent	styling
across	your	whole	document	a	snap.A	document	can	hold	infinite	pages,	so	don't	be	shy	when	creating	them.	Lots	of	times	I	treat	pages	like	branches	in	development:	a	new	area	to	test	things	out	without	affecting	my	master	design.	Exploration	is	the	key	to	design,	and	pages	make	it	super	easy.ArtboardsAn	artboard	is	a	fixed-size	frame	inside	a
page,	and	they	help	group	and	organize	screens	while	working	on	Sketch's	infinite	canvas.	Artboards	great	when	working	with	responsive	design,	because	you	have	have	multiple	screen	sizes	sitting	right	next	to	each	other.Here's	a	look	at	artboards	in	use	inside	our	sample	document	Artboards	are	also	made	for	exporting,	which	makes	saving	and
sharing	screens	a	snap.	InVision	can	automatically	sync	your	artboards	into	screens	of	your	prototype.Making	a	new	artboardTo	create	an	artboard,	simply	select	Insert>Artboard,	or	press	the	A	key.	When	creating	a	new	artboard,	Sketch	provides	a	lot	of	predefined	sizes	(common	device,	icon,	and	screen	resolutions).If	you've	already	got	an	artboard
in	place	and	want	another	one	(handy	for	creating	a	new	view	from	an	existing	screen),	select	the	artboard	and	press	Cmd+D	to	instantly	duplicate	it.Sometimes	when	I'm	working	on	a	complex	flow,	my	pages	will	contain	dozens	of	artboards	laid	out	in	a	logical	flow.	It's	a	great	way	to	picture	the	user	funnel	while	working,	seeing	everything	in	one
space.StylingAll	styling	(colors,	fonts,	sizing,	fills,	borders,	etc)	in	Sketch	is	contained	in	The	Inspector,	a	glorious	sidebar	that	helps	keep	in	the	craziest	layouts	in	check.As	a	quick	example,	let's	take	a	look	at	the	Inspector	when	we've	got	our	logo	shape	selected.Check	out	the	exact	pixel	location,	width	and	height,	opacity,	fill,	and	more.	The
Inspector	contains	everything	you	could	possibly	want	to	know	about	or	edit	for	any	selected	element	Every	single	bit	of	styling	info	for	the	element	is	shown	all	at	once,	in	an	organized	and	manipulable	interface.	If	you've	ever	done	any	front-end	development,	you	should	feel	right	at	home	here.Saving	brand	colors	for	easy	useSketch's	color	palette
tool	makes	it	really	easy	to	save	and	reuse	colors,	perfect	for	keeping	things	on-brand	as	you	hop	around	the	document.	You	can	save	colors	to	the	document	(available	on	all	Pages),	or	globally	to	Sketch	itself	(available	in	all	documents).In	our	sample	.sketch	file,	I've	saved	our	key	colors,	purple	and	orange,	into	the	Document	Colors,	for	quick	and
easy	reference	To	save	a	new	swatch,	start	by	selecting	your	desired	color	(either	by	entering	a	hex	value	or	using	the	picker).	Next,	just	click	the	+	icon	under	the	"Document	Colors"	or	"Global	Colors"	section.	Your	selected	color	will	be	added	to	the	list	of	swatches,	ready	for	use.Bonus:	even	if	you	haven't	saved	any	colors,	Sketch	keeps	track	of
colors	you've	used	and	how	often	you've	used	them.	To	pick	from	your	frequent	colors,	use	the	dropdown	arrow	hidden	inside	the	color	preview	well	(the	block	of	color	showing	the	currently	selected	color).Creating	our	document	(all	together	now!)With	our	new-found	appreciation	for	pages,	artboards,	and	styles,	let's	go	ahead	and	set	up	our	.sketch
document	scaffold.	Since	the	example	site	we're	building	is	going	to	be	responsive,	we'll	make	both	desktop	and	mobile	sized	artboards	as	we	go.Words:	Clark	Wimberly	(opens	in	new	tab)Want	to	learn	more	about	designing	with	Sketch?	Get	Clark	Wimberly's	10-part	InVision	ecourse,	Design	Workflow	with	Sketch,	delivered	right	to	your	inbox.	Keep
an	eye	on	the	InVision	blog	(opens	in	new	tab)	to	be	one	of	the	first	to	know	when	you	can	sign	up.Liked	this?	Read	these!	Thank	you	for	reading	5	articles	this	month*	Join	now	for	unlimited	accessEnjoy	your	first	month	for	just	£1	/	$1	/	€1	*Read	5	free	articles	per	month	without	a	subscription	Join	now	for	unlimited	accessTry	first	month	for	just	£1	/
$1	/	€1	Learning	how	to	draw	perspective	correctly	could	change	your	entire	drawing	process.	Whether	drawing	traditionally	with	pencil	and	paper,	or	digitally	using	a	graphics	tablet,	I	still	construct	even	the	most	complicated	scenes	entirely	using	the	draughting	techniques	of	the	horizon	line	and	vanishing	points	that	most	people	will	have	learnt	in
art	class.This	might	seem	strangely	over-complicated,	when	it's	so	easy	to	quickly	mock	up	a	basic	version	of	the	scene	using	3D	modelling	programs	to	guide	your	drawing,	but	when	you	set	out	a	perspective	drawing	by	hand,	you	give	yourself	some	flexibility	in	interpreting	the	method.	In	following	and	often	slightly	bending	these	rules,	you	enrich
the	narrative	composition	of	the	image	by	adding	depth,	drama	and	atmosphere.	Here	are	some	of	the	methods	that	I	use	most	frequently,	including	one-point	perspective	and	two-point	perspective.Also	read	our	guide	to	the	art	techniques	you	need	to	know,	and	our	roundup	of	the	best	how	to	draw	tutorials.Click	on	the	top	right-hand	corner	of	each
image	to	enlarge	it.	(Image:	©	Anna	Mill)	The	most	important	decision	is	the	placement	of	the	horizon	line	in	relation	to	the	important	characters	and	elements	such	as	objects,	furniture	or	buildings	in	the	scene.	It's	useful	to	remember	that	the	horizon	is	on	the	same	level	as	the	imagined	eye	of	the	viewer.When	you	place	the	horizon	line	above	the
characters,	it	gives	the	viewer	the	impression	that	they're	in	a	position	higher	up,	looking	down	from	a	platform,	say.	If	we	imagine	that	our	viewer	is	standing	on	the	same	surface	as	the	other	characters	in	the	scene,	then	all	standing	figures	in	the	scene	will	also	have	their	head	on	the	horizon	line,	with	the	exception	of	particularly	tall	or	short
characters.If	the	horizon	line	is	low,	and	the	characters	stretch	high	above	the	horizon,	then	it	appears	as	if	the	viewer	is	lying	down	on	the	same	surface,	or	standing	on	a	lower	platform	looking	up.	In	my	graphic	novel	Square	Eyes	(opens	in	new	tab)	I	would	often	set	the	horizon	line	either	very	low	or	very	high	in	the	drawing.	It	seemed	to	fit	with
the	tone	of	the	book,	in	which	the	main	character	is	often	confused	and	disoriented	by	surroundings	that	either	loom	above	her	or	stretch	away	in	inhumanly	vast	vistas.	(Image:	©	Anna	Mill)	The	above	image	shows	one-point	perspective	with	the	horizon	line	placed	low	in	the	frame,	but	level	with	the	figures	to	show	them	being	dwarfed	by	the
buildings.In	one-point	perspective,	horizontal	lines	on	any	plane	perpendicular	to	the	point	of	view	will	recede	to	a	vanishing	point	that's	located	somewhere	on	the	horizon	line.	Usually,	I	avoid	putting	the	vanishing	point	right	in	the	middle	of	the	space	that	I'm	drawing,	because	it	tends	to	create	too	much	symmetry	in	the	view,	making	the
composition	feel	static	and	a	little	unnatural.	Yet	sometimes	this	eerie	calm	can	add	to	the	atmosphere	of	the	scene.	(Image:	©	Anna	Mill)	With	this	example	of	two-point	perspective,	both	vanishing	points	are	out	of	frame	and	the	horizon	line	is	centred	on	the	image,	giving	a	natural,	low-tension	feeling	to	the	scene.When	drawing	two-point
perspective,	I	always	place	either	one	or	both	of	my	vanishing	points	outside	the	edges	of	the	drawing.	I	find	that	when	both	the	left	and	right	vanishing	points	are	inside	the	frame,	dramatic	perspective	angles	are	created.	This	sometimes	generates	objects	that	look	strangely	stretched.	For	the	most	part	however,	I	want	a	more	natural	field	of	view,
so	I	take	care	to	locate	the	vanishing	points	in	such	a	way	that	they	create	a	good	balance	between	drama	and	realism.	(Image:	©	Anna	Mill)	I	have	various	sets	of	rulers	of	my	own	making	that	I	use	when	carrying	out	traditional	paper	and	pencil	perspective	drawing.	The	simplest	ones	are	cut	from	mount	board	and	pivot	on	a	drawing	pin	that	acts	as
the	vanishing	point.	This	enables	me	to	quickly	move	the	ruler	around	the	page,	and	know	that	any	line	that	I	draw	against	the	draughting	edge	will	recede	to	that	vanishing	point.	This	can	be	set	up	with	as	many	rulers	and	vanishing	points	as	is	required,	but	typically	I	only	use	one	or	two	at	once.The	image	above	shows	two-point	perspective	with	a
low	horizon	line	and	vanishing	point	far	right	out	of	the	frame	to	enhance	the	feeling	of	distance	and	scale.	It's	not	always	possible	to	have	a	ruler	long	enough	or	table	wide	enough	to	allow	your	ruler	to	be	physically	connected	to	the	vanishing	point.	What's	needed	is	a	ruler	that	will	reliably	pivot	about	a	point	to	which	it's	not	actually	connected.	This
was	an	enjoyably	tricky	problem	that	I	grappled	with	for	many	years,	before	finally	coming	up	with	a	solution	that	involved	fixing	three	rulers	together,	which	moved	around	two	drawing	pins.		(Image:	©	Anna	Mill)	When	drawing	digitally	in	Photoshop,	I	find	that	it's	usually	too	cumbersome	to	expand	the	canvas	to	draw	all	the	perspective	lines
receding	to	a	vanishing	point	to	the	far	left	or	right	outside	the	scene.	In	this	case	I	tend	to	add	a	basic	square	grid	for	guidance,	which	I	adjust	to	the	main	perspective	lines	using	the	program's	Skew	tool	(Edit	>	Free	Transform	>	Skew).	This	usually	provides	enough	guidance	that	more	detailed	lines	can	be	drawn	by	eye,	even	if	they	don't	fall
exactly	on	a	gridline.Drawing	digitally	also	allows	for	some	other	timesaving	shortcuts,	particularly	when	drawing	repeating	elements	in	perspective,	such	as	a	building	that	has	many	windows	of	the	same	size	and	shape.	Here's	my	method	for	depicting	repeating	elements.	First,	draw	one	window	and	save	the	file,	calling	it	'Single	Window'.	Next,
create	a	new	document,	go	to	File	>	Place	Linked...	and	choose	your	Single	Window	file.	Add	as	many	multiples	of	the	window	as	you	need,	arranging	them	to	suit	the	facade	of	the	building	that	you	are	drawing.	Then	save	the	file	as	'Facade	1'.Now	create	a	new	document,	and	Place	Linked	file	Facade	1.	You	can	now	skew	the	facade	to	the
perspective	that	you	need,	without	having	to	draw	all	the	windows	individually.	In	addition,	if	you	make	a	change	to	your	Single	Window	file,	then	all	the	copies	will	also	update	in	the	perspective	view.	Finally,	link	the	facade	file	and	skew	to	suit	the	perspective	in	the	scene.	(Image:	©	Anna	Mill)	It's	only	when	some	extraordinarily	complex	shape	is
required	that	I	ever	use	3D	modelling	software	to	help	generate	the	image.	This	is	partly	from	a	stubborn	delight	in	a	technical	drawing	challenge,	but	also	because	apart	from	the	flexibility	it	gives	you,	it	also	allows	for	some	mistakes.	I	feel	it's	in	these	small	errors	we	make	when	we	craft	something	by	hand	that	some	of	our	personality	shows
through	in	the	work.I	feel	like	my	inaccuracies	are	probably	specific	to	me,	and	that	I	make	the	same	small	mistakes	in	similar	ways	over	and	over	again	when	drawing.	The	nearer	that	a	draughtsman	gets	to	robotic	perfection,	the	less	present	are	the	signs	of	a	human	hand	and	mind	creating	those	small	inaccuracies	that	are	unique	to	that	artist,	and
I	believe	that,	even	if	it	takes	a	little	longer,	this	is	something	that	is	worth	preserving.	The	final	image,	based	on	the	initial	perspective	drawing	above	(Image	credit:	Anna	Mill)This	article	was	originally	published	in	issue	301	of	Computer	Arts	magazine.	Buy	issue	301	(opens	in	new	tab).Read	more:	Thank	you	for	reading	5	articles	this	month*	Join
now	for	unlimited	accessEnjoy	your	first	month	for	just	£1	/	$1	/	€1	*Read	5	free	articles	per	month	without	a	subscription	Join	now	for	unlimited	accessTry	first	month	for	just	£1	/	$1	/	€1
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